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Electronics for Closed Loop Control
Operation Manual Series PID00A-40X

A WARNING — USER RESPONSIBILITY

FAILURE OR IMPROPER SELECTION OR IMPROPER USE OF THE PRODUCTS DE-
SCRIBED HEREIN OR RELATED ITEMS CAN CAUSE DEATH, PERSONAL INJURY AND
PROPERTY DAMAGE.

This document and other information from Parker-Hannifin Corporation, its subsidiaries and
authorized distributors provide product or system options for further investigation by users having
technical expertise.

The user, through its own analysis and testing, is solely responsible for making the final selection
of the system and components and assuring that all performance, endurance, maintenance,
safety and warning requirements of the application are met. The user must analyze all aspects
of the application, follow applicable industry standards, and follow the information concerning
the product in the current product catalog and in any other materials provided from Parker or its
subsidiaries or authorized distributors.

To the extent that Parker or its subsidiaries or authorized distributors provide component or
system options based upon data or specifications provided by the user, the user is responsible for
determining that such data and specifications are suitable and sufficient for all applications and
reasonably foreseeable uses of the components or systems.
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1. Introduction

Parker electronic modules PIDO0A-40* for rail The described electronic unit combines all neces-
mounting are compact, easy to install and provide sary functions for the optimal operation of closed
time-saving wiring by disconnectable terminals. loop controls.

The digital design of the circuit results in good ac-

curacy and optimal adaption for closed loop con-

trols by a comfortable interface program.

1.1 Front view / dimensions

75

45 110

1.2 Ordering code

o m - @ - (] - [

Electronic Universal Min/Max Technology Design
module adjustment function series
closed loop accel/decel ramps
control command input
controller -
Code Function
0 Standard
1 Linearization

1.3 Name plate
CE€ Darke |

+Vs 18_30V—{ 1] | 11— Pot Supply -10V
ov— 2] % 112[— Pot Supply +10V
+— 8] 19 [—RefOV
0vV—13 | 7 [~ Cmd Output
Sensor Supply«—{16
Fdbk Input—14 ||
Fdbk Input—{15) 110f— Monitor
Cmd Input—{ 5|
Cmd Input—{ 6 j>? -
H 3 |—Enable
HC  H4|—Status
Type
Bitte Betriebsanleitung Artikel:
beachten [ PIDO0A-400-40
Pleasg refer to the Made in Germany
operation manual YFB7F BP
40982889 PIDO0O T
L Date code
——— Check sum
Order code
Wiring diagram
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1.4 Block diagram

N | [ L, .
voltage 0 suppl
> —2 L= 12— +1ov PPy
- —s| L—Jof—
—
13 0...+-10V
sensor 0...+-20mA oot
supply +18.30v  +— 16 > / > o rsoma __outeut ]
4..20mA
sensor — 14 [
input .
—l15 10 | 000
0.0 —f 5 |-
0...+-20mA
4..20mA —) 6 |
B Py -
WC g s

1.5 Characteristics

* Extended PID controls » Parametering via USB interface

» Velocity control with position feedback » Connection by disconnectable terminals

» Differential input stage with different signal op- <« Compatible to the relevant European EMC
tions standards

« Output stage with different output options » Optional technology function "linearization"

* Four-quadrant ramp function » Comfortable PC user software, free of charge:

« Status indicator www.parker.com/isde - see "Support", or di-

rectly at www.parker.com/propxd.

Digital circuit design

€
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1.6 Technical data

General
Model Module package for snap-on mounting on EN 50022 rail
Package material Polycarbonate
Inflammability class VO acc. UL 94
Installation position Any
Ambient temperature range [°C] | -20...+60
Protection class IP 20 acc. to EN 60529
Weight [g] | 160
Electrical
Duty ratio [%] | 100
Supply voltage [VDC] | 18...30, ripple < 5 % eff., surge free
Current consumption max. [mA] | 100
Pre-fusing [mA] | 500
Command signal options [V]1]| +10...0...-10, ripple <0.01 % eff., surge free, Ri = 100 kOhm
[mA] | +20...0...-20, ripple <0.01 % eff., surge free, Ri = <250 Ohm
[mA] | 4...12...20, ripple <0.01 % eff., surge free, Ri = <250 Ohm
<3.6 mA = solenoid output 0V/0 mA/12 mA acc. output option
>3.8 mA = solenoid output on (acc. NAMUR NE43)
Input signal resolution [%] | 0.025
Differential input voltage max. [V] | 30 for terminals 5 und 6 against PE (terminal 8)
Status signal [V]|0...0.5: Off / Us: On / rated max. 15 mA
Enable signal [V]]0...1: Off / 5...30: On / Ri = 100 kOhm
Monitor signal [V] | +10...0...-10, rated max. 5 mA, signal resolution 0.4 %
Output signal options [V]|+10...0...-10, rated max. 15 mA
[mA] | +20...0...-20, Ro < 500 Ohm
[mA] | +50...0...-50, Ro < 200 Ohm
[mA] | 4...12...20, Ro < 500 Ohm
Output signal resolution [%] | 0.025
Potentiometer supply [V]]| +10...0...-10 2 %, rated max. 15 mA
Sensor supply [V]| 18...30 (Us), rated max. <100 mA
Adjustment ranges Min [%] | 0...50
Max [%] | 50...100
Ramp [s]|0...32.5
Zero offset [%] | +100...-100
Interface USB type B
EMC EN IEC 61000-6-2, EN IEC 61000-6-4
Connection Screw terminals 0.2...2.5 mm?, disconnectable
Cable specification [AWG] | 20 overall braid shield
Cable length [m] | 50
Options
Technology function Code1 | Software adjustable transfer function with 10 compensation

points for linearization of valve behaviour.
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1.7 Signal flow diagram
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2. Safety instructions

Please read the operation manual before installa-
tion, startup, service, repair or stocking! Paying no
attention may result in damaging the electronics or
incorporated system parts.

2.1 Symbols
This manual uses symbols which have to be fol-
lowed accordingly:

A Instructions with regard to the warranty

Instructions with regard to possible dam-
aging of the electronics or linked system
components

> Helpful additional instructions

2.2 Marking, name plates

Instructions applied on the electronics, i.e. wiring
diagrams and name plates, must be observed and
maintained legibly.

2.3 Work at the electronics

Working in the area of installation and commis-
sioning of the electronics may only be allowed by
qualified personnel. This means persons who due
to education, experience and instruction, have suf-
ficient knowledge of relevant directives and ap-
proved technical rules.

PIDO0A 5715-616 UK.indd 12.05.22

3. Important details
3.1 Intended usage

This operation manual is valid for module electron-
ics PIDO0OA-40X series. Any use diverging or go-
ing beyond is deemed to be as not intended. The
manufacturer is not liable for warranty claims re-
sulting from this.

3.2 Common instructions

We reserve the right of technical modifications
of the described product. lllustrations and draw-
ings within this manual are simplified representa-
tions. Due to further development, improvement
and modification of the product, the illustrations
might not match precisely with the described de-
vice. The technical specifications and dimensions
are not binding. No claim may resulting fromit. Cop-
yrights reserved.

3.3 Liability
The manufacturer does not assume liability for
damage due to the following failures:
+ incorrect mounting / installation
* improper handling
+ lack of maintenance
» operation outside the specifications
Do not disassemble the electronics! In case

of suspicion for a defect please return the unit
to the factory.

3.4 Storage

In case of temporary storage the electronics must
be protected against contamination, atmospheric
exposure and mechanical damages.

Parker Hannifin Corporation
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4. Mounting / Installation
4.1 Scope of supply

Please check immediately after receiving the elec-

tronics, if the content is matching with the specified

scope of supply. The delivery includes:

* module electronics

* operation manual

> Please check the delivery immediately after
receiving the shipment for apparentdamages
due to shipping. Report shipment losses at
once to the carrier, the insurance company
and the supplier!

4.2. Mounting

« Compare electronics type (located on the name
plate) with part list resp. circuit diagram.

* The module may be mounted in any direction.

* The module has to be mounted within a shield-
ed environment (i.e. control cabinet).

* For mounting an assembly rail acc. EN 50022
is required.

Dimensions assembly rail
35

4

} R0.8

—-175

27

Work flow for module installation
Mounting:

1. Apply the module with the assembly rail guide at
the lower edge of the rail.

2. Engage the module upward.

i ®

ol

PIDO0A 5715-616 UK.indd 12.05.22

Removing:

1. Lift the metal socket lock with a suitable screw-
driver (approx. 4x1 mm blade) against the spring
force.

2. Demount the module at the top edge of the as-

sembly rail.

i

L—

©)

4.3 Operational limits

The electronics may be operated within the de-
termined limits only. Please refer to the “technical
data” section.

Follow the environmental conditions! Unal-
lowable temperatures, shock load, moisture
exposure, radiation exposure, illegal elec-
tromagnetic emissions may result in system
malfunction and may lead to failure! Follow
the operating limits listed in the “specifications”
table!

4.4 Electrical connection

The electrical connection of the module electron-
icsis via the front accessible screw terminal blocks.

> This easy-to-install connection allows fast
module replacement and a visible separation
of the electrical connection. An additional fold-
ing “unlocking lever® allows simple removing
of the terminal blocks and serves at once as
shock hazard protection and marking strip.

Parker Hannifin Corporation
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The connecting wires have to comply to the follow-
ing specification:

Wire type: hookup cable, stranded
Cross sections: min. AWG 20/0.5 mm?
Wire length: max. 50 m

(> For wire lengths > 50 m consult factory.

Skinning length for the connection wires
g—

The screw terminals are designed to allow termi-
nation of all kinds of copper wires without the need
for preparation. Copper wire end sleeves may usa-

ble as conductor stripping protection for the strand-
ed wires.

Soldering of the connection wires is not per-
mitted.

To ensure EMC-compatibility the wiring of the mod-
ule has partly to be undertaken by shielded ca-
bles. Detailed information relating to this subject
are available in the chapter entitled “Electrical In-
terfacing”.

The installation should only be undertaken by
qualified personnel! Ashortbetweenindividual
conductors, loose wires or improper shielded
connections may result in malfunction and
breakdown of the electronics resp. the con-
nected valve!

The mounting surface of the valve must be
grounded to the machine frame. Both end
of the interconnecting cable shield must be
grounded and tied to terminal 8. It is neces-
sary to use a low ohmic potential connection
between control unit and machine frame to
prevent earth loops (cross section min. AWG
6 /10 mm?).

PIDO0A 5715-616 UK.indd 12.05.22

4.5 Electrical interfacing

Supply Voltage:
The supply voltage for the electronics is connect-

ed via terminals 1 and 2 of the module electronics,
the range of which is 18...30 V, residual ripple may
not exceed 5% eff.

The applied power supply must comply to
the relevant regulations (DIN EN 61558) and
must carry a CE-mark. The operating voltage
for the electronics must be free of inductive
surges. Do not exceed the max. value of
30 V! Non-observance of this rule may result
in permanent damaging of the electronics
resp. the connected valve!

The increased inrush current of the valve
should be considered when selecting the
power supply. A stabilized power supply with
“over current” limiting feature should not be
used. Due to the inrush current of the elec-
tronics the current limit circuit may respond
prematurely and create problems during
energizing of the supply voltage.

A

Wiring diagram of supply voltage

1]2]3]4]5]6]7][8
electronic

control system

module
oliofi1i2hsfi4fisfe

The operation of the electronics is blocked if
the supply voltage polarity is inverted.

Each electronics module requires a separate
pre-fuse of 0.5 Amp time lag. Non-observance
of thisinstruction may create irreparable dam-
age of electronics resp. incorporated system
parts.

10
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Enable input

A signal voltage applied to the terminals 3 and 13
enables the solenoid output of the electronics. Con-
tinuous operation of the electronics requires a per-
manent voltage 5...30V (i.e. the supply voltage). In
case of disabling the signal the output of the elec-
tronics will be switched off in no time independently
from the command signal value. At the same time
the controller output will be clamped. In case of re-
starting the enable signal, the output signal wave-
form defaults to the zero position of the controller.
Preferably the enable signal should be switched on
together with the hydraulic pressure supply to avoid
unwanted reaction of the down streamed system.

The enable function should not be considered
to be a safety arrangement in isolation but
should form a partof an overall safety systems
strategy.

Wiring diagram of enable input

Command signal input

The command signal will be connected to the ter-
minals 5 and 6 of the difference signal input of
the electronics. All inter connecting signal cables
should be shielded and appropriately grounded.
By means of reviewing and subsequent selection
of the programmable parameters different com-
mand signal can be utilized as described below.
For the function description terminal 6 is assumed
as signal reference (0V).

> Details are available in the technical specifi-
cations. The parameter options for the com-
mand signalinputare described in the chapter
“Operating Instructions®.

The command input signal should be filtered
and free ofinductive surges/modulations there
by providing a high quality in signal averting
drive malfunctions.

Incorrect signal amplitude levels may disturb
functionality and may damage the module!

E@—‘
1]2]3]4]5]6]7]8
. enable signal solenoid output
electronic U313
enable . disabled
. <1,0V
signal ] e
module - ;
>5.30V active
NREEDER
oV |
control system
PIDO0A 5715-616 UK.indd 12.05.22
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Wiring diagram of voltage command input +10...0...-10 V

command
signal

]
1]2[3]4]5]6]7]8

control system

electronic

module

9 [10[11]12[13[14]15]16

Wiring diagram of voltage command input +20...0...-20 mA

command
signal

1]2[3]4]5]6[7]8

control system

electronic

]

module

o [10[11[1213]14]1516

Wiring diagram of current input 4...12...20 mA

command command signal solenoid output
signal | 5-6 signal output
. <3.6 mA off
i > —
| 5-6 signal output
control system 1|2|3|4|5|6|7|8 > 3.8 mA on

electronic

module

9 [10[11]12]13[14]15]16

The4...20mAoption uses the “0 mA” condition
as breakdown-information. This means the
presence of an evaluable failure information
if the input signal line is interrupted. In this
case the solenoid output will be switched off.
The output will switched on when the input
signal reaches a value of 3.8 mA, it switches

off when the command falls below 3.6 mA.
This is in line with the NAMUR-specification
NEA43. If necessary, the command signal cable
break detection can be disabled by selecting
the parameter E19.

NAMUR is an association of users of pro-
cess control technology.

PIDO0A 5715-616 UK.indd 12.05.22
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Monitor output (optional comparator output)

Areference voltage representing the feedback sig-
nal is available from terminals 10 and 13. The
voltage span of +10 V ..0..-10 V equates to
+100...0...-100 % feedback signal range. The sig-
nal resolution of this output averages 8 bit = 0,4
%. In case of a breakdown within the sensor ca-
ble the monitor output will be switched off, provid-
ed that the feedback signal cable break detection
is in use (parameter E12).

Wiring diagram of monitor output

If a comparator window for the feedback signal
monitoring is defined via parameter P21, the out-
put generates a voltage signal of 0 V if the upper
or lower threshold is detected. Within the window
the output value is typ. 10 V.

> The monitor output is not calibrated and is a
simple trend indicator.

The output may drive a load of max. 5 mA.
Exceeding this limit leads to malfunction.

Um
monitor

_ @ - I
signal
oV

I o

control system

Status output

Connections to 4 and 13 provides status informa-
tion related to the electronics . The following infor-
mation is available:

» feedback signal cable break (not for voltage op-
tions / £20 mA)

» command signal cable break (only for option
4..20 mA)

» internal processor fault
* enable off

Wiring diagram of status output

Ust

[ASiS18)

feedback monitor signal
U 1013
0...+100 %
1]2[3]4[5]6]7]8 ° 0..410V
U 10-13
electronic 0 - oV
o U 10-13
0..-100 % 0,10V
module
cable break U 10-13
REEDER sensor ov
steady state error monitor signal
<+ % P21 U 1013
>-%P21 | 10V
>+ % P21 U 1013
<-% P21 oV

The output may drive a load of max. 15 mA.
Exceeding this limit leads to malfunction.

1]2[3]4]5]6]7]8

electronic
status
signal

V) <+

{oV]

.

control system

PIDO0A 5715-616 UK.indd 12.05.22

condition status signal
U4-13

system o.k. Us 18...30V
cable break U 4-13
sensor > <05V
cable break command U4-13
(f. option 4..20 mA) <05V

module

processor failure <Uo4é13
U4-13
enable off <05V

9 [10[11[12[1314]1516
[

13
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Signal output

The terminals 7 and 9 provides the output signal
(set value), which may be used to control exter-
nal amplifier modules, integrated valve amplifiers
as well as servo valves. Different versions of out-
put signal processing are available, which are de-
scribed below.

Wiring diagram of voltage output +10...0...-10 V

Uo

The output signal option has to be selected
according to the requirements of the down-
streamed electronic (parameter E20).

output
signal

Oks

\
1]2[3]4]5]6]7][8

FEREEEDR
\

oV

control system

Wiring diagram of current output +20...0...-20 mA

I

lo

output
signal

Oks

\
1]2[3]4][5]6]7][8

electronic

L

module

9[1011/12[13[14/15/16

lo

control system

Wiring diagram of current output +4...12...20 mA

L

lo

output
signal

94—

\
1]2[3]4]5]6]7]8
I REEER
\

lo
control system

Sensor input

The sensor has to be wired to the terminals 13 and
16, the earth ground connection will be made via ter-
minal 8. The connection has to be shielded. The sen-
sor type is selectable via software parameter E11.

PIDO0A 5715-616 UK.indd 12.05.22

Connection of an inappropriate sensor may
lead to permanent damage to the electronics
module.

—Parker “
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Wiring diagram of sensor input 0...¥10 V

ov

electronic

[sTafrfishe

> output

0..+-10V
< supply

+18...30V

sensor

Wiring diagram of sensor input 0...+20 mA / 4...12...20 mA, 3-wire

electronic

oV

output

= 0..+-20mA
4.12..20mA

supply
<+ +18...30V

sensor

Wiring diagram of sensor input 0...+20 mA / 4...12...20 mA, 2-wire

output

electronic

module
9[10[11]12/13[14{15[16|
i LI

—» 0..+-20mA
4.12..20mA

<« supply

+18...30V/

sensor

PIDO0A 5715-616 UK.indd 12.05.22
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Wiring Examples

Partially the wiring requires a shielded per-
forance. for the sake of clarify the appropriate

illustration is ommitted.

Example 1

Closed loop position control of a hydraulic cylin-
der, utilizing a proportional directional control valve
with integrated electronics (D*FP). Command sig-
nal preset using a potentiomater.

diagnostics
status t
enable [ Ue ‘ ‘ [
1]2]3]4]5]6]7]8 Py
electronic @
® 5 ®
PIDO0A-40x @ @
@ valve
ofdi1f12131415]1¢ ~F—1 oFp
drive [ ]
diagnostics
ov oV
position common N
command y g
= 10kl o 3
10V 5..10k ov [0)Y] 9 g
g2
3 g8
U L’:":
+U
: [ ]
control system Sensor drive
PIDOOA 5715-616 UK.indd 12.05.22
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Example 2

Closed loop position control of a hydraulic cylinder,
performed via proportional directional control valve
with external electronic (D*FC, D*FS). Command

preset via external control signal.

valve diagnostics

valve status

position command

drive status

enable

drive diagnostics

L] \
1]2]3]4]5]6]7]8

|
1]2]3]4]5]6]7]8

PIDO0A-40x

electronic 2

PWDXXA-40x

R RIEETER

CREEREDR

0V common

control system

W o N

>
ol
5 B sensor
3 @ valve
35 D*FC, D*FS
92
Q|
3 o8
U
s
sensor drive
PID00A 5715-616 UK.indd 12.05.22
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Example 3

Closed loop pressure control within a hydraulic
cylinder, performed utilizing a proportional pres-
sure control valve with external electronic (RE*W,
VMY). Command preset via external control signal.

valve status

pressure command

control status

enable

] \
1]2[3]4]5]6]7]8

|
1]2[3]4]5]6]7]8

electronic 1

L

PIDO0A-40x

PCDO00A-400

olto11f1213145/16

ofidi1f12131415)1¢

feedback diagnostics

0V common

control system

PIDO0A 5715-616 UK.indd 12.05.22

oV
feedback
sensor supply

p

sensor

valve
RE*W, VMY

drive
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Example 4

Closed loop position control of a hydraulic cylin-
der, utilizing a proportional directional control valve
(D*FB) with external drive electronics PWDOQO.
Command preset via external control signal.

valve status

position command

drive status ‘ ‘
enable ‘ ‘ ‘ ‘
1]2]3]4]5]6]7]8 1]2]3]4]5]6]7]8
electronic 1 electronic 2
el —
m PWDO0A-400
oltof11f1213141516 I REEER

drive diagnostics

0V common

control system

2
of
al
5 a valve
85 D*FB
g2
> Q|
3 93
U
s
sensor drive

PIDO0A 5715-616 UK.indd 12.05.22
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5. Operating instructions

The electronics module performs the task of com-
paring the command input signal value with the
feedback signal value (eg. cylinder position). The
difference is then feed to a closed loop controller,
that in turn provides an output to a power ampli-
fier stage which sets the value for the valve drive
amplifier.

5.1 Operating software program

ProPxD parameterizing software:

The ProPxD software provides a simple and easy
to use interface for perameter selection within the
module. The menu and drop down tables facilitate
an easy selection of parameter values. Once the
parameters have been selected they may be stored
for future use (Floppy disc or Hard drive), output-
ted as a text file for documentation purposes or
down loaded to the none volatile module memory.
Stored parameter sets may be loaded anytime and
transmitted to the module electronics in the same
manner as the basic parameters which are available.
Inside the electronics a nonvolatile memory stores
the data with the option for recalling or modification.

ProPxD screenshot

The connected drive may not operated before
loading the appropriate parameter set from
the PC into the module electronics!

Features

+ Easy to use editing of all parameters

+ Display and documentable parameter settings

* Loading and storage of optimized parameter
settings

* Compatible with all Windows® operating sys-
tems from Windows® XP upwards

* Plain communication between PC and electron-
ics module via USB interface

The PC software can be downloaded free of charge
at www.parker.com/isde — see page “Support" or
directly at www.parker.com/propxd.

cable break detaction cmd in

Type of feedback

Max [%] A-channel
Max [%] B-channel
Min [%] A-channel
Min [%] B-channel
ramp up [ms] A

rarmp down [ms] A
ramp up [ms] B

ramp down [ms] B

feedback scale (%] )
cable break detaction fdb 1= aclive
Command Dutput (see Installation man)

Fade out ramp (ETYEED)
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Operating made 0=0pen loop; 1=closed; 2=eden

command signal D=nol invartied, 1=Invertied

Feedbackvalue D=not Inveried, 1=imvertied |
output signal ied, 1=invertie

bypass gain |%]
T-partion of PT1-glement
P-gain

l-gain

D-gain

T-portion of DT1-element

VWindow for -gain activation [%]
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Hardware requirements

* PC with a minimum operating system of Win-
dows® XP upwards

* USB interface

« display resolution min. 800 x 600

« storage requirement approx. 4 MB

> Itis recommended to select “small fonts” at
the display setting, otherwise distortion of the
display may occur.

After connecting the module to the computer via a
USB cable, Windows recognizes the module and
installs a USB serial port. This port must be select-
ed in ProPxD under Options-Interface.

The COM port is displayed in the Windows device
manager under "Ports (COM & LPT)" as USB Se-
rial Port (COMx). If there are several USB serial
ports in the device manager, the USB serial port
of the module can be identified by unplugging the
module cable - the corresponding entry in the de-
vice manager disappears. If it is plugged in again,
the entry with the corresponding USB serial port
appears again.
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5.2 Program installation

Please check before the installation of the above
hardware that the system requirements are met.
In addition to which, if your PC has already stored
an older version of the “ProPxD” program, it should
be deleted by using the Windows® - system con-
trol feature.

Program installation sequence

» Terminate the execution of other programs.
* Insert ProPxD-software CD.

» Execute the file “setup.exe”.

* Follow the instructions on the screen.

Answer the question, if an older version should
be overwritten, with “ok”. During the installation
you may change destination drive resp. installation
path, if needed (i.e. if the storage space on drive
“c” is not sufficient).

Please answer also “ok” if at the end of the instal-
lation the program reports any system information.
After successful installation the desktop display
shows the ProPxD icon for starting the program.

According to the operating system the installation
of some drivers (DLLs) may be disabled. Failure
messages relating to this may be ignored. Prior to
the updating of older versions these has to be dein-
stalled via the Windows® Contol Panel.

—Parker i
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5.3 Software operating

Incorrect settings may lead to malfunction!
In case of parameter changes shut the drive
down!

Brief instruction for first startup

Connect the module electronics to the sup-
ply voltage.

Connect the module to a PC via USB cable.
Click on the ProPxD icon to start the operat-
ing program.

After displaying the program resp. data base
version a program window opens and the con-
nected electronics will be automatically identi-
fied (possibly a manual identification via the but-
ton “Receive all” is necessary).

Select the desired version via the menu “Op-
tions” with the menu item “Language”.
Select the engaged valve from the provided
type table via the menu “Options™ and the item
“Valve type”.
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Subsequently the program inserts the default
parameters into the parameter table.

Individual parameters may be selected viamouse
or the arrow buttons at the center of the pro-
gram screen.

Parameter changes are possible via mouse or
the arrow buttons on the bottom left within the
program screen, also the parameter values may
be edited via the keyboard.

Modified parameters will be stored via the “En-
ter” key or via the button “Update list”.

After completing of all madifications, the entire
parameter set may be transmitted to the elec-
tronics via the button “send all”, also the pa-
rameters will be nonvolatile stored.

The chosen parameters may be optionally stored
on the PC via the “File” menu with the menu
item “Save as”, data retrieving is always pos-
sible via the function “Load out of database”

22

Parker Hannifin Corporation



Operation Manual

Electronics for Closed Loop Control
Series PID00A-40X

Extended functions

The user software is shared into 2 parameter ranges:
» basic mode

« expert mode

For normal startup the basic mode is sufficient. It
permits the setting of all application specific pa-
rameters to match the valve function with the task
setting, the default parameters will be selected from
the valve library. In case of special applications the
parameters may be adapted via the expert mode.
The operating mode may be selected from the “Op-
tions” menu and remains after termination and re-
start of the program.

Changing of expert parameters is only permit-
ted by qualified personnel.

To prevent an unauthorized access for the expert
mode, a password is required. The name is “park-
er” and cannot be changed. Thus additionally to
the button “Default” for loading of the default pa-
rameters, the button “Send parameter” appears
in the “Expert”-operating mode. This button trans-
mits only the setting of one single parameter to the
connected module electronics. Thus a quick tuning
of single parameters is permitted during the setup.
> A horizontal bar graph readout between
the communication buttons shows the data
transfer state.

5.4 Adjustment parameters

The available parameters may be divided into
multiple groups and are characterized by different
letters:

S-parameters
P-parameters
E-parameters

internal commands and ramps
operating parameters
extended parameters
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Additional to the device parameters, the electron-
ics stores also the device types, selected from the
valve library. Via the button “receive all” the valve
parameters will be read out of the electronics and
stored including the valve type. If expert parame-
ters will be modified and transferred, the valve in-
formation memory inside the electronics will be
erased and the word “customized” is shown with-
in the valve display area. Via an arrow button lo-
cated beside the view boxes of “Type”, “Design
series” and “Valve”, the corresponding selection
table may be accessed.

> Because the ProPxD program has also offline
(i.e. without connection to the electronics)
functionality, a manual pre-selection of the
parameters is possible. After selection of the
electronics type via the menu “Options” the
parameters may be set and stored for later
transmission. Note the design series while
selection of the electronics!

The “File” menu provides the functions “Printer
setup”, “Print preview” and “Print”. The print
preview includes the option for parameter set stor-
age as text file (format .txt) prior to further process-
ing. The “Options” menu provides also the change
of the virtual com port via the menu item “Port”. Via
the menu item “Load out of database” previously
stored parameter sets may be loaded.

> Information on the technology functions is
provided within the help function of the operat-
ing software.
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Parameter overview for basic mode

e ) Parameter range )
Parameter Description Unit Default setting
from up to
S5 ramp accel. A ms 0 32500 0
S6 ramp decel. A ms 0 32500 0
S7 ramp accel. B ms 0 32500 0
S8 ramp decel. B ms 0 32500 0
S18 fade out ramp ms 0 32500 0
P3 MAX A % 50.0 100.0 100.0
P4 MAX B % 50.0 100.0 100.0
P7 MIN A % 0.0 50.0 0.0
P8 MIN B % 0.0 50.0 0.0
P11 polarity command - 0 1 0
P12 polarity feedback - 0 1 0
P20 feedback scale % 0 200.0 100.0
P29 polarity set value - 0 1 0
0 = inactive (open loop) X i
E2 closed loop control - i 0 = inactive
2 = active (closed loop)
1=%10V
2 =120 mA
sensor type _ — 4. ; =
E11 feedback 3 =4-20 mA bipolar 1= %10V
12 = 4-20 mA unipolar
15 =0-10 V unipolar
voltage: 0 (inactive)
. current £20 mA:
cable break detection . . . . _ .
E12 feedback - 0 (inactive) 0 (inactive) 0 = (inactive)
current 4-20 mA:
1 (active)
1=%210V
E17 option command input - 2=120 mA 1= 210V
3 =4-20mA
. +10 V: 0 (inactive)
E19 LI SC R Tl - 0 (inactive)  |£20 mA: O (inactive)| 0 = inactive
command
4-20 mA: 1 (active)
1=%210V
2 =120 mA
X 3 =4-20 mA bipolar
E20 option command output - ] 1= %10V
12 = 4-20 mA unipolar
15 =0-10 V unipolar
16 = £50 mA
PIDOOA 5715-616 UK.indd 12.05.22
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Individual description of basic parameters

S5
ramp accel. A

S6
ramp decel. A

S7
ramp accel. B

S8
ramp decel. B

S18
fade out ramp

P3
MAX A

P4
MAX B

P7
MIN A

P8
MIN B

P11
command signal polarity

P12
feedback signal polarity

P20
feedback scale

P29
polarity set value

E2
closed loop control
E11
type of feedback device
E12
cable break detection
feedback
E17
type of command signal
device
E19
cable break detection
command

Adjustment of ramp rate for increasing of positive polarity signal.
To avoid switching noise.

Adjustment of ramp rate for decreasing of positive polarity signal.
To avoid switching noise.

Adjustment of ramp rate for increasing of negative polarity signal.
To avoid switching noise.

Adjustment of ramp rate for decreasing of negative polarity signal.
To avoid switching noise.

Adjustment of ramp rate for position dependent decreasing of signal.
To automate motion sequences.

Adjustment of maximum signal span for positive polarity output signal.
To match the command signal span to the drive operating range.

Adjustment of maximum signal span for negative polarity output signal.
To match the command signal span to the drive operating range.

Adjustment of positive polarity signal step.
To compensate for the overlap of the valve spool.

Adjustment of negative polarity signal step.
To compensate for the overlap of the valve spool.

Adjustment of the command signal polarity.
To match the command signal polarity to the control path.

Adjustment of the feedback signal polarity.
To match the sensor signal polarity to the control path.

Adjustment of the feedback scaling.
To match the drive operating range to the feedback input signal span.

Adjustment of the set value signal polarity.
To match the set value signal polarity to the control path.

Adjustment of the operating mode for the controller.
To select the control function.

Adjustment of the feedback device type.
To match the feedback input to the signal device features.

Adjustment of the operating mode for the feedback cable break detection.

To turn on resp. off of the cable break detection for the feedback signal.

Adjustment of the command signal option.
To match the command signal input to the input signal mode.

Adjustment of the operating mode for the command cable break detection.

To turn on resp. off of the cable break detection for the command signal at

a selected command signal option of 4...20mA..

PIDO0A 5715-616 UK.indd 12.05.22
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Parameter overview for expert mode

e ) Parameter range )
Parameter Description Unit Default setting
from up to
P1 zero % -100.0 +100.0 0.0
P13 bypass gain % 0 100.0 0
P14 T-portion PT1-element - 0 100.0 0
P16 P-portion - 0 100.0 0
P17 I-portion - 0 100.0 0
P18 D-portion - -100.0 +100.0 0
P19 T-portion DT1-element - 0 100.0 0
P21 comparator function window % 0 200.0 0
P23 comparator rise delay time ms 0 10000 0
P24 °°mz::‘;°{irt#;”'°ﬁ ms 0 10000 0
P26 window I-portion % 0 20 20
P27 reduct. window I-portion - 0 100.0 100.0
P28 T-portion PT1-filter - 0 100.0 0
E25 MIN operating threshold - 0=1% 0=1%
1=0.01%

E50 average quantity - 1 10 1

. 0 = inactive . .
E70 velocity feedback - i 0 = inactive

1 = active
E71 MIN position % -120.0 +120.0 -120.0
E72 MAX position % -120.0 +120.0 +120.0
E73 sensor length mm 1 10000 10000
E74 MAX velocity mm/s 1 10000 10000
) 0 = y=X (synchronous)
E75 set value output function - 0 =y=x
1 =y=1-x (reversal)

E79 MIN fadeout position % -120.0 +120.0 -120.0
E80 MAX fadeout position % -120.0 +120.0 +120.0
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Individual description of expert parameters

P1

offset
P13

bypass gain
P14
T-portion of PT1

P16

P-portion
P17

I-portion
P18

D-portion
P19

T-portion of DT1
P21

window for comparator

function
P23

comparator rise delay time

comparator turn-off delay
time
P26
window for |-gain activation
P27
I-gain window reduction

P28
T-portion of PT1-filter
E25

MIN operating threshold
E50

average quantity
E70

velocity feedback

E71
MIN position

E72
MAX position

E73

sensor length
E74

MAX velocity
E75
set value output function

E79
MIN fadeout position

E80
MAX fadeout position

Adjustment of zero position shifting (offset).

To compensate for unbalances.
Adjustment of the bypass gain for the controller.

To improve the control dynamic via feed forward factor.

Adjustment of the integral action time for the PT1-portion of the controller.
To attenuate for the P-portion.

Adjustment of the P-portion for the controller.

For the basic tuning of the controller.

Adjustment of the |-portion (integration time) for the controller.

To reduce the control failure.

Adjustment of the D-portion for the controller.

To improve the control dynamic.

Adjustment of the pre-hold time for the DT 1-portion of the controller.
To attenuate for the D-portion.

Adjustment of the comparator window for the feedback monitoring.
To adjust the feedback monitoring range.

Adjustment of the comparator rise delay time.
To delay the rise threshold for the comparator function.

Adjustment of the comparator turn-off delay time.
To delay the turn-off threshold for the comparator function.

Adjustment of the I-portion active range in terms of the control difference.
To limit the I-portion on a certain range.

Adjustment of the I-portion outside the window in terms of the control
difference.

To match the response behavior of the I-portion.

Adjustment of the damping for the PT1-portion of the sensor.

To smooth the differentiated velocity feedback signal.
Adjustment of the MIN operating threshold.

To match the response sensitivity for the stroke step.
Adjustment of the number of samples for average calculating.

To smooth the velocity feedback signal.

Adjustment of the velocity control mode.

To select the control function.

Adjustment of the MIN switching point for the immediate set value reduc-
tion to zero.

To automate motion sequences.

Adjustment of the MAX switching point for the immediate set value re-
duction to zero.

To automate motion sequences.

Adjustment of the sensor length.

To calculate the feedback signal for velocity control.
Adjustment of the MAX velocity.

To match the command signal span to the velocity range.
Adjustment of the set value signal waveform.

To match the set value developing to the control path characteristic.
Adjustment of the MIN switching point for the ramped set value
reduction to zero.

To automate motion sequences.

Adjustment of the MAX switching point for the ramped set value reduc-
tion to zero.

To automate motion sequences.
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27 Parker Hannifin Corporation



Operation Manual

Electronics for Closed Loop Control
Series PID00A-40X

5.5 Guideline for closed loop applications

Practical guidelines for the adjustment of the con-
trol parameters are summarized below. They are
divided into different application categories and in-
clude common rules of thumb.

The commissioning of a closed loop systems
requires detailed knowledge of process control
technology. Therefore on-site works support
is recommended.

Anincorrectwiring resp. parameter setting may
lead to malfunction and permanent damaging
of electronics and drive system!

5.5.1 Application: Closed loop systems for po-
sition

Introduction

The electronics uses a feedback control loop which
automatically adjusts the electrical input to the
valve amplifier to move the drive to a command-
ed position. At the heart of this feedback loop is a
digital controller which computes and updates the
signal output (set value output) every one milli-
second. The controller has adjustable coefficients,
which must be set by the user for the particular
application.

The controller provides a standard PID control ca-
pability plus extra features you can use to improve
the performance beyond the limits of PID.

Basic information for the control algorithm
Why tuning?

The controller can be used with valves that vary
greatly in flow capacity, frequency response, satu-
ration and deadband, with different kinds of load,
and with cylinders of any area and stroke. The user
must adjust the control coefficients for the specif-
ic system. There are no fixed sets of values for the
controller coefficients that will handle every situ-
ation well.

The electronics utilizes a “PID” controller for its ba-
sic control action. The name PID comes from the
fact that the controller output is the sum of three
terms, called proportional (P), integral (I) and de-
rivative D), each with a user adjustable coefficient.
The user software provides therefore the parame-
ters P16 (P), P17 (l) and P18 (D).
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P -P16

This term provides an immediate output signal,
proportional to the error between commanded and
measured position. If this parameter is set too high,
sustained oscillations may occur. If it is set too low,
accuracy and speed of response may be poor.

1 -P17

This term causes the output to change at a rate
proportional to the error in measured position over
time (integration time), in a direction to drive the
steady state error to zero. P17 is active within a
window, which might be adjustable by parameter
P26. P26 shall be adjusted in the way that the win-
dow lies near the final position or in the stationary
range of the drive. A too higher value of P17 caus-
es oscillations, in addition to which the selection
of a too lower value may result in a slow action.

D -P18

The D-term provides an output proportional to the
rate of change of the measured drive position. De-
pending on the polarity of the parameter prefix, this
term causes damping or acceleration. For hydrau-
lic drives this term should be set to a low value.

Parameter ranges

The controller provides two parameter ranges of
BASIC and EXPERT. The BASIC mode serves
for adjustment of the fundamental function pa-
rameters, while the application specific setting of
the control coefficients may be made via the EX-
PERT mode. The operating mode is selected via
the menu OPTIONS.

Simple tuning of a position control loop

Before trying anything complicated, you should
adjust the proportional gain, accessible by P16.
In many cases this coefficient will be all you need,
and you will not have to bother with any of the oth-
er control features. If you do need the other fea-
tures, you cannot adjust them properly without first
adjusting the P-gain. Adjusting the P-gain is done
by setting all the other control coefficients P13 — 19
as well as P26 —28 to zero and increasing P16 to
the highest value that does not result in sustained
oscillations of the drive position.
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Guarantee of control functionality

Before the tuning of the control loop may be com-
menced, the functionality of the control circuit must
be ensured. As previously mentioned, the control-
ler compares command and feedback signal and
adjusts the electrical input to the valve amplifier to
move the drive to the commanded position. To en-
sure this functionality, the polarities of command
and feedback signal must be equal.

How can the functionality of the control loop
be achieved?

At first you should set off the control loop (set pa-
rameter E2 to value 0 = open loop and transmit to
the electronic) and cause the drive via manual con-
trol to the middle of the cylinder stroke. Afterwards
adjust at first the control coefficients as described
in chapter “Simple tuning of a position control loop”
(P16 at 10 %) as well as the parameter E2 at 2 =
external closed loop and transmit to the electron-
ic. If this results in a rapid movement of the drive
to an end position, the polarities are incorrect. Ac-
cess now the parameter P12 = feedback signal po-
larity, change the value and transmit the data. The
drive should be adjustable and remain in its position
when you switch on the closed loop control via pa-
rameter E2. Now you should preset position com-
mands and supervise the drive movement. If the
drive even tough is running in closed loop mode,
but the direction of the movementis not as required,
you have to change the polarities of both command
and feedback signal via the parameters P11 and
P12. After that the drive is running as desired, you
can continue with tuning of the loop.

Tuning of the closed loop control

1. Create a suitable tuning test profile — otherwise
it may be difficult for you to tell how good the
system response is (the test profile may also be
generated by an upstreamed electronic module
PZD00A-400). The test profile should so pro-
grammed to causing the drive to move from the
start position with the desired maximum acceler-
ation and velocity to the required final position. In
the final position the drive should be commanded
to dwell, that will give you enough time to watch
the load position to see if it oscillates or remains
stationary. This should be followed by returning
of the drive to the start position, where the dwell
in position may also be evaluated.
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2. Check once more to be sure that P17 and P18
are set to zero.
3.Adjust P16 to a low value, i.e. 10 %, and try the

system on the test profile.

Observe the result of the test. There are three

possible outcomes:

» The drive oscillates continuously
Stop the system quickly. Reduce the P16-
value to 2 of the initial guess, and try again.

» The drive overshoots, but stops after one or
two oscillations
Reduce the P16-value to % of the initial-
guess, and try again.

» The drive reaches the commanded position
with no overshoot
The system is usable with the estimated val-
ue of P-gain. You should experiment with
stepwise increasing of the P16-value to see
how high a value the system will tolerate. Ac-
curacy and response are improved by high
values, but do not allow permanent oscilla-
tion!

4.You have now completed the basic tuning for
your control loop. The next step is to test the per-
formance of the system to see if it meets your
requirements. If not, the electronic has addition-
al control features you can use to improve per-
formance, as explained below.

> The parameters P28, E50, E73, E74 will
be needed only for closed loop velocity
control systems and should therefore not
be changed.
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The table below gives information, which approaches may be embarked if typical problems with posi-

tion control loops appear.

Problem

Solution

Position error too large,
when drive is stationary

Repeatable position error by using a valve
with overlap/hysteresis

Position error too large when following
constant velocity position command

Slow, small amplitude, position oscillation

Disappointingly low P-gain

Response too slow

Unexplainable problems

Use parameter P17 = I-gain
(only active if P26 > 0)

Use dead band compensation feature
P7 = MIN channel A resp.
P8 = MIN channel B

Use parameter
P13 = bypass gain

Use integrator window
P26 = window I-gain

Check the frequency response of the valve
and position transducer, or possibly the drive
resonant frequency (s. items below)

Be sure P16 = p-gain is adjusted high
enough (s. also previous items)

Check the setting of all parameters

Improving system performance
Using the parameter P17 = I-gain

The integrator gain (abbreviated I) can be adjusted
to reduce or eliminate the error between the com-
manded position and the position measured by the
feedback transducer, subject to the command re-
maining constant. Higher values of I-gain will cause
the response to be slower and more prone to os-
cillation with the combined effect of a reduced sta-
tionary error. Lower values will require an extended
time to reach zero steady state error. This parame-
teris only active if awindow (> 0) is defined via P26.
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Elimination of slow, small amplitude oscilla-
tion in position

Because of friction and other imperfections, use of
the I-gain sometimes causes a slow, small ampli-
tude oscillation in load position. This is an entire-
ly different problem from the vigorous oscillations
that occur when the P-gain is set too high. The
electronic provides a “Window” feature (sometimes
called “in-position-window”) to solve this problem.
Select the parameter P26. Stepwise increasing of
the window size to a large enough value will stop
the slow oscillations.
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Repeatable position error too large because of
valve dead band or hysteresis

Utilization of the integrated dead band compensa-
tion coefficient enables this effect to be reduced or
eliminated. There are separate adjustable param-
eters P7 and P8 for both valve sides. This feature
generates constant correction signals which will
be active for the dedicated valve site if a signal oc-
curs on the command signal input. As a result this
will cause the valve to “Jump* through the overlap
region of the spool.

Increasing load stiffness

“Load stiffness” is the term given to the resistance
of the servo loop to deflection of the drive by ex-
ternal forces. Adjusting P16 to the highest practi-
cal value is important.

Disappointing control loop function

The higher the value of P-gain that can be used,
the better is the static and dynamic performance of
the system. You may not have any direct need for
fast response, but may still need a high value of P
to reduce static error, reduce following error or in-
crease actuator stiffness. High values of P cause
faster system response, whether you need it or not.
As the system frequency response gets too close
to the frequency response of one of your compo-
nents, the system response becomes oscillatory.
* Valve
The frequency response of the valve can be
obtained from the datasheets. As a first guess, it
needs to be at least twice the system frequency
response.
* Position transducer
Some analog output transducers will present
problems because of filtering intended to smooth
the output. To ensure the best system dynamic,
sensors with integrated D/A-converter should
operate with a high sampling rate. Magnetostric-
tive transducers with digital output often have a
low sampling rate, because an interaction with
the achievable resolution. Please obtain detailed
information from the transducer supplier.
* Drive
There is a mode of mechanical vibration created
by the mass of the load and the compressibility
of the hydraulic fluid in the whole system. This
frequency is often surprisingly low when using
long stroke cylinders.
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Update rate of the controller

The controller updates the electrical output to the
valve at 1000 Hz. This rate is fast enough to have
negligible effect in almost all hydraulic applications,
but it does set an absolute limit on the response
of the system.

Position transducer accuracy and resolution

A control system is no better than its transducer.

Here are points to watch for:

¢ Absolute accuracy
The controller positions the load as closely
as possible to the position measured by the
feedback transducer. The absolute accuracy
of the measured position is determined by the
transducer.

* Resolution
The electronics cannot position the load more
accurately than the resolution of the transducer.
Be sure the resolution of your sensoris adequate.
When using a true analog transducer (analog
measurement principle and analog output), the
resolution is limited by the utilized A/D-converter,
which is 12 bit (1/4096 = 0.025 %).

¢ Installation
The installation of the position transducer plays
amostimportant rule for the proper functionality
of the closed loop control. By all means it has
to be secured, that the mounting of transducer
and actuating device provides absolute freedom
from vibration and clearance effects. This is
mostimportant even for the commonly expected
velocities and accelerations. Also, the transducer
has to be laid out for the dynamic requirements.

—Parker !
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5.5.2 Application: Closed loop systems for
pressure (via pressure control valves)

Introduction

The electronics uses a feedback control loop which
automatically adjusts the electrical input to the
valve amplifier that the commanded pressure ap-
pears. At the heart of this feedback loop is a digi-
tal controller which computes and updates the sig-
nal output (set value output) with a one millisecond
update time. The controller has adjustable coeffi-
cients, which must be set by the user for the par-
ticular application.

The controller provides a standard PID control ca-
pability plus extra features which may be utilized to
improve the performance beyond the limits of PID.

Basic information for the control algorithm
Why tuning?

The controller can be used with valves that vary
greatly in flow capacity, frequency response, sat-
uration, dead band, load, and cylinders with a va-
riety of area and stroke. The user must adjust the
control coefficients for their specific system. There
are no fixed sets of values for the controller coeffi-
cients that will handle every situation.

The electronics uses a “PID” controller for its ba-
sic control action. The name PID comes from the
fact that the controller output is the sum of three
terms, called proportional (P), integral (I) and de-
rivative D), each with a user adjustable coefficient.
The user software provides therefore the parame-
ters P16 (P), P17 (l) and P18 (D).

P -P16

This term provides an immediate output signal,
proportional to the error between commanded and
measured pressure. If this parameter is set too
high, sustained oscillations may occur. If it is set too
low, accuracy and speed of response may be poor.

1 -P17

This term causes the output to change at a rate
proportional to the error in measured pressure, in
a direction to drive the steady state error to zero.
P17 is active when a window will be leaving, which
might be adjustable by parameter P26. P26 shall
be adjusted in the way that the window lies near
the final pressure. A too low a value of P17 causes
low frequency oscillations, with a too higher value
the required pressure may be reached too slowly.
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D -P18

The D-term provides an output proportional to the
rate of change of the measured pressure. Depend-
ing on the polarity of the parameter prefix, this
term causes damping or accelerating. For hydraulic
drives this term should be set to a very low value.

Parameter ranges

The controller provides two parameter ranges, of
course the operating modes BASIC and EXPERT.
Herewith the BASIC mode serves for adjustment of
the fundamental function parameters, while the ap-
plication specific setting of the control coefficients
may be done via the EXPERT mode. The operat-
ing mode may be selected via the menu OPTIONS.

Simple tuning of a pressure control loop

Before trying anything complicated, you should ad-
just the bypass gain, accessible by P13. Herewith
a “feedforward” of the output will be achieved, the
PID-control loop will be “bypassed”. For this ad-
justment all other control parameters P14 —19 as
well as P26 — 28 has to be set to zero. Then P13
will be increased accordingly, until the feedback
signal appears 10...20 % below the command sig-
nal. Mostly a setup value of 40...50 % is practica-
ble. Following is the adjusting of the proportional
gain, accessible by P16.

Adjusting the P-gain is done by increasing P16 to
the highest value that does not result in sustained
oscillations of the pressure. In many cases this two
coefficients will be all you need, and you will not
have to bother with any of the other control features.
If you do need the other features, you cannot ad-
justthem properly without first adjusting the P-gain.

Guarantee of control functionality

Before the tuning of the control loop may be start-
ed, the functionality of the control circuit must be
ensured. As previously mentioned, the controller
compares command and feedback signal and ad-
justs the electrical input to the valve amplifier to
achieve the commanded pressure. To ensure this
functionality, the polarities of command and feed-
back signal must be equal.
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How can the functionality of the control loop
be achieved?

At first you should set off the control loop (set pa-
rameter E2 to value 0 = open loop and transmit to
the electronic) and cause the pressure via manual
control to the middle of the system pressure. Next
adjust the control coefficients as described in chap-
ter “Simple tuning of a pressure control loop” (P16
at 10 %) as well as the parameter E2 at 2 = exter-
nal closed loop and transmit to the electronic. If this
results in a jump of the pressure into its minimum
or maximum final value, the polarities are incorrect.
Access the parameter P12 = feedback signal po-
larity, change the value and transmit the data. By
now the pressure should be adjustable and must
remain on its value when you switch on the closed
loop control via parameter E2. The next task will
be to preset the pressue command and monitor
the pressure behavior. If the pressure even tough
is running in closed loop mode, the behavior of the
pressure rise and fall is not as required, it is nec-
essary to change the polarities of both command
and feedback signal via the parameters P11 and
P12. The control loop should now be running as
desired, you can continue with tuning of the loop.

Tuning of the closed loop control

1. Create a suitable tuning test profile — otherwise
it may be difficult for you to tell how good the
system response is (the test profile may also be
generated by an up-stream electronic module
PZDO00A-400). The test profile should start caus-
ing the system from the circulation pressure with
the desired maximum acceleration and velocity
to the required final pressure. At the final pres-
sure the system should remain for a while, that
will give you enough time to watch the pressure
value to see if it oscillates or remains stationary.
This should be followed by returning of the pres-
sue to the start value, where the stationary val-
ue may also be evaluated.
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2.Check once more to be sure that P17 and P18
are set to zero.

3. Adjust P16 to a low value, i.e. 10%, and run the
system using the test profile.

Observe the result of the test. There are three pos-
sible outcomes:

The pressure oscillates continuously

Stop the system quickly. Reduce the P16-val-
ue to 2 of the initial guess, and try again.
The pressure overshoots, but stops after one
or two oscillations

Reduce the P16-value to % of the initial guess,
and try again.

The pressure reaches the commanded value
with no overshoot

The system is usable with the estimated val-
ue of P-gain. You should experiment with
stepwise increasing of the P16-value to see
how high a value the system will tolerate.
Accuracy and response are improved by high
values, but do not allow permanent oscillation!

4. You have now completed the basic tuning for
your control loop. The next step is to test the per-
formance of the system to see if it meets your re-
quirements. If not, the electronics has addition-
al control features that may be used to improve
performance, as explained below.

> The parameters P28, E50, E73, E74 will

be needed only for closed loop velocity
control systems and should therefore not
be changed.
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The table below gives information, which approaches may be embarked if typical problems with pres-

sure control loops appear.

Problem

Solution

Variation error too large, when pressure
command remains constant

Repeatable deviation by using a valve
with overlap/hysteresis

Sequence error too large when following
pressure command profile

Disappointingly low P-gain

Response too slow

In explainable problems

Use parameter P17 = I-gain
(only effective for P26 >0)

Use deadband compensation feature
P7 = MIN channel A

Use parameter P13 = bypass gain

Check the frequency response of valve
and pressure transducer, and the system
resonant frequency (s. items below)

Be sure P16 = p-gain is adjusted high enough
(s. also previous items) and check the flow
capacity of the valve

Check the setting of all parameters

Improving system performance
Using the parameter P17 = |-gain

The integrator gain (abbreviated |) can be adjust-
ed to reduce or eliminate the error between the
commanded pressure and the feedback pressure
measured by the transducer, when the command
is constant. Higher values of I-gain will cause a bet-
ter error reduction while the response will be long-
er. This parameter is only effective if a window (>0)
is defined via P26.

Eliminating a slow, small amplitude oscillation
in stationary condition

Due to the possible effects of friction and or other
application variables, use of the I-gain sometimes
causes a slow, smallamplitude oscillation in the sta-
tionary condition. This is a different problem from
the vigorous oscillations that occur when the P-gain
is set too high. The electronics provide a “Window”
feature (sometimes called “in-position-window”) to
solve this problem. In this case the integrator oper-
ates only within this window. Select this option via
parameter P26. Step increases of the window size
will eliminate the oscillation.
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Increasing load stiffness

“Load stiffness” is the term for the resistance of the
servo loop characteristics to deflection by external
forces. Adjusting P16 to the highest practical val-
ue is important.

Disappointing control loop function

The higher the value of P-gain that can be used,
the better is the static and dynamic performance of
the system. You may not have any direct need for
fast response, but may still need a high value of P
to reduce static error, reduce following error or in-
crease load stiffness. High values of P cause fast-
er system response, whether you need it or not.
As the system frequency response gets too close
to the frequency response of one of your compo-
nents, the system response becomes oscillatory.
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e Valve
The frequency response of the valve can be
obtained from the datasheets. As a first guess, it
needs to be at least twice the system frequency
response.

* Pressure transducer
Some analog output transducers will present
problems due to the use of filters intended to
smooth the output. To ensure best systemdynam-
ics, sensors with integrated D/A-converter should
operate with a high sampling rate. Magnetostric-
tive transducers with digital output often have a
low sampling rate, causing an interaction with
the achievable resolution. Please obtain detailed
information from the transducer supplier.

e System
The cutoff frequency will be determined by mass
and compressibility of the hydraulic media in the
entire system (cylinder, piping, valves). Mostly
the value is quite low, particularly for the usage
of large system volumes.

Pay attention for pressure peaks!

High pressure peaks may occur particularly at
closed loop pressure controls systems. Therefore
the dynamic pressure behavior should be inves-
tigated after the controller tuning utilizing a data
aquisition device such as a storage oscilloscope.
If the measured pressure peaks exceed the system
design hardware specification, reductions may be
achieved by adjustment of the control parameters.

Update rate of the controller

The controller updates the electrical output to the
valve at 1000 Hz. This rate is fast enough to have
negligible effectin almost all hydraulic applications,
but it does set an absolute limit on the response
of the system.
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Pressure transducer accuracy and resolution

A control system is no better than its transducer.

Here are points to watch for:

¢ Absolute accuracy
The controller adjusts the system as closely
as possible to the pressure measured by the
feedback device. The absolute accuracy of the
measured pressure is also determined by the
transducer. On the other hand, die signal span of
the transducer should be oversized to achieve a
safe operation evenif pressure peaks appeared.
For example a system pressure of 300 bar re-
quires a sensor with 400 bar nominal pressure.
This results in a value of 75 % for the feedback
scaling P20 (300bar means 75 % of 400 bar).

* Resolution
The electronics is unable to set a pressure more
accurately than the resolution of the transducer.
Be sure the resolution of your sensor is adequate.
When using a true analog transducer (analog
measurement principle and analog output), the
resolution is limited by the utilized A/D-converter,
which is 12 bit (1/4096 = 0.025 %).

* Installation
The installation of a pressure transducer plays
an important role in the proper functionality of a
closed loop pressure control system. The pres-
sure transducer should be located as close to
the point of control as is practical.

Example: A closed loop pressure control is
required for a given hydraulic cylinder. In this
case the pressure control valve and transducer
should be mounted close together, otherwise
poor closed loop control will result.
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5.5.3 Application: Closed loop systems for
velocity (via proportional directional control
valves)

Introduction

The electronics in a feedback control loop auto-
matically adjusts the electrical input to the valve
amplifier to move the drive with the desired com-
manded velocity. At the heart of this feedback loop
is a digital controller which computes and updates
the signal output (set value output) every one mil-
lisecond. The controller has adjustable coefficients,
which must be set by the user for the particular ap-
plication.

The controller provides a standard PID control ca-
pability plus extra features you can use to improve
the performance beyond the limits of PID.

Basic information for the control algorithm
Why tuning?

The controller can be used with valves that vary
greatly in flow capacity, frequency response, satu-
ration, dead band, loads, and cylinders with differ-
ing areas and stroke. The user must adjust the con-
trol coefficients for their specific system. There is
no fixed set of values for the controller coefficients
that will handle every situation.

The electronics uses a “PID” controller for its ba-
sic control action. The name PID comes from the
fact that the controller output is the sum of three
terms, called proportional (P), integral (I) and de-
rivative D), each with a user adjustable coefficient.
The user software provides therefore the parame-
ters P16 (P), P17 (l) and P18 (D).

P -P16

This term provides an immediate output signal,
proportional to the error between commanded and
measured velocity. If this parameter is set too high,
sustained oscillations may occur. If it is set too low,
accuracy and speed of response may be poor.

I -P17

This term causes the output to change at a rate
proportional to the error in measured pressure, in
a direction to drive the steady state error to zero.
P17 is active when a window will be leaving, which
might be adjustable by parameter P26. P26 shall be
adjusted in the way that the window lies near the
commanded velocity. Too low a value of P17 caus-
es low frequency oscillations, with too high a value
the required pressure may be reached too slowly.
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D -P18

The D-term provides an output proportional to the
rate of change of the measured drive velocity. De-
pending on the polarity of the parameter prefix, this
term causes damping or accelerating. For hydraulic
drives this term should be set to a very low value.

Parameter ranges

The controller provides two parameter ranges, of
course the operating modes BASIC and EXPERT.
Herewith the BASIC mode serves for adjustment of
the fundamental function parameters, while the ap-
plication specific setting of the control coefficients
may be done via the EXPERT mode. The operat-
ing mode may be selected via the menu OPTIONS.

Simple tuning of a velocity control loop

Before trying anything complicated, you should ad-
just the bypass gain, accessible by P13. Herewith
a “feedforward” of the output will be achieved, the
PID-control loop will be “bypassed”. For this adjust-
ment all other control parameters P14 —19 as well
as P26 — 28 should be set to zero. Then P13 will
be increased accordingly, until the feedback sig-
nal appears 10...20% below the command signal .
In most cases a setup value of 40...50% is practi-
cable. The next action is to adjust the proportional
gain, accessible by P16.

Adjusting the P-gain is achieved by increasing P16
to the highest value that does not result in sus-
tained oscillations of the drive. In many cases the
adjustment of two coefficients will be sufficient, and
it will not be necessary to utilize any of the other
control features. If you do need the other features,
you cannot adjust them properly without first ad-
justing the P-gain.

36

Parker Hannifin Corporation



Operation Manual

Electronics for Closed Loop Control
Series PID00A-40X

Guarantee of control functionality

Before the tuning of the control loop can com-
mence, the functionality of the control circuit must
be ensured. As previously mentioned, the control-
ler compares command and feedback signal and
adjusts the electrical input to the valve amplifier to
ensure the required velocity. To ensure this func-
tionality, the polarities of command and feedback
signal must be equal.

How can the functionality of the control loop
be achieved?

Firstly you should set off the control loop (set pa-
rameter E2 to value 0 = open loop and transmit
to the electronic) and cause the drive via manual
control to a medium velocity. Subsequently adjust
the first control coefficients as described in chap-
ter “Simple tuning of a velocity control loop” (P16 at
10 %) as well as the parameter E2 at 2 = external
closed loop and transmit to the electronic. If this re-
sults in a jump of the drive into its minimum or max-
imum velocity, the polarities are incorrect. Access
now the parameter P12 = feedback signal polari-
ty, change the value and transmit the data. By now
the drive should be adjustable and must remain on
its actual value when you switch on the closed loop
control via parameter E2. Now you should preset
velocity commands and supervise the drive move-
ment. If the drive even tough is running in closed
loop mode, but the direction of the rise and fall of
velocity is not as required, you have to change the
polarities of both command and feedback signal via
the parameters P11 and P12. After that the closed
loop control is running as desired, you can contin-
ue with tuning of the loop.

Tuning of the closed loop control

1. Create a suitable tuning test profile — this will
enable you to evaluate your system response (A
test profile may be generated by an up-streamed
electronic module PZD0O0A-400). The test profile
should cause the drive to move from the start
position with the required maximum accelera-
tion to the required velocity. At the commanded
velocity the drive should dwell at that rate, this
will give you the opportunity to observe the load
velocity for oscillation. This should be followed
by returning of the drive with a different velocity
to evaluate also the opposite drive direction.
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2. Check once more to be sure that P17 and P18
are set to zero.

3. Adjust P16 to a low value, i.e. 10 %, and try the
system on the test profile.

Observe the result of the test. There are three pos-
sible outcomes:
* The drive oscillates continuously
Stop the system quickly. Reduce the P16-value
to %2 of the initial guess, and try again.

» The Velocity overshoots the commanded value,
but stops after one or two oscillations
Reduce the P16-value to % of the initial guess,
and try again.

* Thedrive reaches the commanded position with
no overshoot
The system is usable with the estimated value
of P-gain. You should experiment with stepwise
increasing of the P16-value to see how high a
value the system will tolerate. Accuracy and
response are improved by high values, but do
not allow permanent oscillation!

4. You have now completed the basic tuning for
your control loop. The next step is to test the
performance of the system to see if it meets
your requirements. If not, the electronic has ad-
ditional control features you can use to improve
performance, as explained below.

> The parameters P28, E50, E70, E73, E74
will be needed for closed loop velocity
control systems and should therefore be
adjusted accordingly (s. section “Generat-
ing feedback signals”).
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The table below gives information, which approaches may be embarked if typical problems with veloc-

ity control loops appear.

Problem

Solution

Variation error too large, when velocity
command remains constant

Repeatable deviation by using a valve
with overlap/hysteresis

Following error too large during
velocity profile execution

Slow, small amplitude oscillation
during constant velocity

Disappointingly low P-gain

Response too slow

In explainable problems

Use parameter P17 = I-gain
(only effective for P26 >0)

Use dead band compensation feature
P7 = MIN channel A resp.
P8 = MIN channel B

Use parameter P13 = bypass gain

Use integrator window P26 = window I-gain

Check the frequency response of valve
and position transducer, the drive resonant
frequency and the feedback value processing
(s. items below)

Be sure P16 = p-gain is adjusted high
enough (s. also previous items)

Check the setting of all parameters

Improving system performance
Using the parameter P17 = |-gain

The integrator gain (abbreviated I) can be adjusted
to reduce or eliminate the error between the com-
manded and the measured velocity, when the com-
mand remains constant. Higher values of I-gain will
cause a better error reduction while the response
will be slower. This parameter is only effective if a
window (>0) is defined via P

Elimination of a slow oscillation with small am-
plitude in position

Due to friction and other application/system char-
acteristics, use of the I-gain sometimes causes a
slow, small amplitude during constant velocity. This
is a different problem from the vigorous oscillations
that occur when the P-gainis set too high. The elec-
tronic provides a “Window” feature (sometimes
called “in-position-window”) to solve this problem.
Select the parameter P26. Small step adjustments
increasing the window size, sufficient to stop the
slow oscillations.
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Repeatable velocity errors due to valve dead
band or hysteresis

You can use the integrated dead band compensa-
tion coefficient to compensate for this. There are
separate adjustable parameters P7 and P8 for both
valve sides. This feature generates constant cor-
rection signals which will be active for the dedicated
valve site if a signal occurs on the command signal
input. As a result this will cause the valve to “Jump
through* the overlap region of the spool.
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Increasing load stiffness

“Load stiffness” is the term for the resistance of
the servo loop to drive deflection by external forc-
es. Adjusting P16 to the highest practical value is
important.

Disappointing control loop function

The higher the value of the P-gain that can be used,
will result in better static and dynamic performance
of the system. You may not have any direct need
for fast response, but may still need a high value
of P to reduce static error, reduce following error or
increase actuator stiffness. High values of P cause
faster system response, whether you need it or not.
As the system frequency response gets too close
to the frequency response of one of your compo-
nents, the system response becomes oscillatory.
e Valve
The frequency response of the valve can be
obtained from the datasheets. As a first guess, it
needs to be at least twice the system frequency
response.
* Position transducer
Some analog output transducers will present
problems because of filtering intended to smooth
the output. This is most important for this appli-
cation, because in this case the actual velocity
feedback signal will be calculated from the posi-
tion transducer signal. To ensure best system
dynamic, sensors with integrated D/A-converter
should operate with a most high sampling rate.
Magnetostrictive transducers with digital output
often have a low sampling rate, because an in-
teraction with the achievable resolution. Please
obtain detailed information from the transducer
supplier.
* Drive
There is amode of instability caused by a combi-
nation of the mass of the load and the compress-
ibility of the hydraulic fluid in the system. This
frequency is often surprisingly low when using
long stroke cylinders.
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Update rate of the controller

The controller updates the electrical output to the
valve at 1000 Hz. This rate is fast enough to have
negligible effect in almost all hydraulic applications,
but it does set an absolute limit on the response
of the system.

Generating feedback signals

The electronics derives the feedback signal for the
velocity control from the differentiation of the posi-
tion transducer output signal. The disadvantage of
such a circuit is the creation of noise in the feed-
back signal. Thus different filter algorithms are im-
plemented. To match the functionality of a certain
feedback generator to the utilized position trans-
ducer, the parameters below have to be adjusted:

T-portion of PT1-filter — P28

This parameter is usable for the adjustment of the
low pass filter damping of the differentiated feed-
back signal. The higher this parameter value is, the
better is the smoothing of the feedback signal within
the controller, but all the damping of the filter. Thus
the level of the parameter has negative influences
to the dynamic of the control.

Average quantity — E50

To smooth the differentiated feedback signal sev-
eral values will be sampled resulting in an average
value. The bigger the number of values will be se-
lected, the better is the quality of the feedback sig-
nal. This function is dedicated for the noise sup-
pression and has virtually a filter function.

Yet the average quantity creates negative effects
for the dynamic of the feedback signal.

Feedback velocity — E70

This parameter enables the generation of the ve-
locity-feedback signal from a position transduc-
er signal.
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Sensor length — E73

The specification of the sensor length is required
for calculating the velocity.

MAX velocity — E74

Required to match the maximum velocity with
100 % command signal span. Example: That re-
sults for a command signal span of 0...10 V a ve-
locity which is adjusted by this parameter.
> The performance of the velocity signal may
be examined via the diagnostic function of the
operating software. For this purpose begin
with starting of the ProPXD-Software.
» Type the key combination “CTR + S + E”
* The service window will be opened, type the
passwort “service”
« Select test point “MP5”
» Close the service window
* Release the diagnostic screen via the menu
“service” below “monitor”
« Tick the “monitor output signal” box
» The button “start” activates the display of the
feedback signal
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Position transducer accuracy and resolution

A control system is no better than its transducer.
Here are points to watch for:

* Absolute accuracy
The controller accelerates the drive with the
highest possible accuracy to a velocity, which
has been measured by the position transducer
and converted to the feedback signal via the
above decribed calculation. The absolute ac-
curacy of the measured position is determined
by the transducer.

* Resolution
The electronic cannot position the load more ac-
curately than the resolution of the transducer. Be
sure the resolution of your sensor is adequate.
When using a true analog transducer (analog
measurement principle and analog output), the
resolution is limited by the utilized A/D-converter,
which is 12 bit (1/4096 = 0.025 %).

+ Installation
The installation of the position transducer plays
a mostimportant rule for the proper functionality
of the closed loop control. By all means it has
to be secured, that the mounting of transducer
and actuating device provides absolute freedom
from vibration and clearance effects. This is
mostimportant even for the commonly expected
velocities and accelerations. Also, the transducer
has to be laid out for the dynamic requirements.
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5.6 Fade out function

This function allows for a controlled fade out of the
output signal, independently from the command
signal processing. This might be useful as simple
“semi automatic” while operating a cylinder ap-
proach, or as adjustable system limit.

The diagram below explains the mode of operation.

output signal

switching point switching point

(set value) parameter parameter
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switching point switching point
parameter parameter
E71 E79

The ranges may be used independently from each
other. Onerange is inactive, if it contains the default
values given from the operating software.
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output signal
(set value)
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5.7 Error messages

Malfunctions when using the ProPxD software pro-
gram will be indicated via appropriate failure mes-

sages.

Failure messages and corrective actions

Failure message

Description/corrective action

The Com Port is not available!

Unable to open COM port

There is no module connected or
the communication is disturbed!

Wrong password!
Wrong input!

Keep the entered parameters?

The chosen module isn’t the same
as the connected hardware!

File name.pxd already exists. Do
you want to replace the file?

Terminate the other program, or quit the message and select
another RS-232 port via the menu “Options > Port”. Afterwards
reconnect the null modem cable.

Com port is not available. Quit the message and select another
virtual com port via the menu “Options > Port”.

No data exchange possible. Either the electronics has been re-
moved, the portis mismatched, or the connection will be disturbed
by strong electrical fields. Check if the Com port is set for “9600,
8, 1. none, none” via the menu “Options > Port”.

Retype the password, notice the exact spelling

(case sensitivity).

An invalid character or a value outside the permitted range has
been used at parameter entry.

During parameter loading from the electronics module memory
the preset parameters from the left hand screen display may be
rejected or maintained.

In principle, parameters dedicated to a type which deviates from
the connected electronics module may be edited. However, for data
transmitting the correct module has to be connected. If parameters
will be loaded from a module which deviates from the selected
one, the parameters from the left hand side screen display of the
program will be overwritten.

The file name already exists within the indicated directory. Select
another name, another directory or overwrite the existing file
with “OK”.
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6. Maintenance

Periodical maintenance is essential for the lon- Service work may only be carried out by
gevity of the unit and guarantees reliability and qualified personnel. Detailed knowledge of
availability. the machine functions concerning switching
The following properties of the electronics have on and off as well as of the required safety
to be checked in continuous short time intervals: relevant technical tasks is necessary!

« tight fit on the mounting rail

« tight fit of the disconnectable terminals
« tight fit of the terminal screws

* environmental temperature level

* supply voltage level

» cleanliness of the ambience

7. Trouble-shooting Function assignment
Basis of trouble-shooting is always a systemat- ; " ;
ic approach. At first the following questions have | Operating condition LED-display
to be checked: no failure green
. fArle the?re practical experiences with similar | o supply voltage off
ailures”? .
no enable signal ellow
* Have system adjustments been changed? g Y
cable break feedback sensor
> Ineithercase the available diagnostic options (not for options voltage/+-20 mA) red
should be used. The electronics permits a .
diagnostic of the valve function via the monitor cable break_command signal red
output. The status output monitors the work- .(only for option 4...20 mA)
ing condition of the electronics, an additional | internal processor fault red

visual status results from an LED indicator.

Afterwards starting of trouble-shooting by means of
a priority list of the most likely reasons.

Trouble-shooting in a hydraulic system re-
quires in either case a systematic approach.
The work may exclusively be performed by
Location of status indicator qualified personnel, as it requires detailed
knowledge of the function and construction
of the system. Reversals or disassembly may
not be taken imprudently! Prior to the works
it has to be clarified, if the system has been
operated properly until the failure occured.

staus @ status indicator
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